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GEO 465/565
Lab 5 — GPS Data Collection & Mapping

Collecting Waypoints in the Field

This exercise is designed to familiarize you with several key features of a standard consumer
grade GPS. Using a Garmin eTrex Legend, you will learn how to:

Parts in red are optional

v' Check the Satellite availability to determine which satellites and how many will be available at
certain times of the day for your study location.

v' Prepare the eTrex for use including setting its reference coordinate system/datum and
changing the Time Zone.

v" Collect and record waypoints in the field representing distinguishable land features
(buildings).

v" Download the waypoints from the GPS to the computer and add to ArcView.

Checking Satellite Availability

In planning a GPS data collection effort, one of the first considerations should be that of
determining the number of satellites that will be available for your particular study area on the
date and time of day that you plan to collect data. Time of day is important in terms of when
satellites are in your area. Depending on your location and the potential for signal interference,
ideally, you would choose a time of day to correspond with the maximum number of satellites
available and the signal strength of those satellites.

We will determine the number of satellites available for our location by accessing this Interactive
Satellite Prediction site:
http://sirius.chinalake.navy.mil/satpred/

Use these parameters for Oregon State University:

Latitude (degrees®minutes’seconds”) = 44°34'03” N
Longitude (degrees®minutes’seconds”) = 123°16'37” W

Time = [(our current time in Pacific Daylight time) + (??? hours from GMT or UTC
(Universal Time) on a 24 hour clock)].

Altitude = 246 feet (convert this elevation to meters first)
Elevation Mask = 15 degrees

1. Determine which satellites will be available during our class period and note their
assigned numbers on the GPS record worksheet. Also look at the graphic representation of
each satellite orbit in relation to your stated coordinate location (OSU). To do this, click on the
graphic icon of the world for each satellite.

2. Enter different times of the day and determine when, in a 24 hour period, the most
satellites would be available for our coordinate location (OSU). Note this on the GPS
record worksheet as well.
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1 Field Procedure Summary

Each field group (2 students) should have a GPS unit and a GPS record worksheet. With this
equipment, each group should assemble in the parking lot east of Wilkinson Hall and initialize the
eTrex GPS units for use.

We will be creating the digital information on OSU support buildings which were not include in the
official campus map but play an important role in academic life at OSU

We will be collecting waypoints to delineate the outline of Kelly Engineering building, the new

COAS building (outlined in the parking lot adjacent to Wilkinson with flags), the Environmental
Lab addition to Burt Hall, Fung's Maple Garden, and one waypoint apiece for the Beanery and
Subway.

Note that we may have 10-12 satellites in our region if the horizon is clear of buildings and trees,
etc. But as we will be collecting waypoints adjacent to buildings, we should expect some
degradation in the number and strength of the satellite signals. Note that the positional accuracy
of these units is <15 meters (49 feet) without any Differential or WAAS augmentation. We have
been able to accuracy readings of 14 feet with these units. The key is to stand at each data
location long enough to track a sufficient number of satellites.

Each group will record the following data for each waypoint collected as per the GPS Record
Worksheet format shown at the end of these instructions:

Date/Time

Group members (and number of GPS receiver)

Coordinate System and Datum used to mark the waypoints

WAYPOINT ID as displayed on the receiver for each waypoint you collect

The latitude, longitude and elevation for each waypoint you collect

Accuracy information (in feet) as displayed on the Map page

Attribute information that will be entered into the attribute table for each point (waypoint)
when it is converted into a shapefile in ArcView. Note the following information for 2 different
attributes: Cardinal direction for corners of building, using the compass to determine the
direction; and the name of building.

ANENENENENENEN

Detailed Instructions:

NOTE:

v" Words in [BRACKETS] refer to either individual buttons on the sides of the receiver or the
round Click Stick on the receiver face.

v" Note that the [CLICK STICK] allows you to move up/down or right/left to move through menu
options, highlight fields, on-screen buttons, icons, enter data or move the map panning arrow.
Although there is only one physical Click Stick, pressing the top, bottom, left or right portion of
the key will result in the appropriate cursor movement, designated with these symbols
[11[} [<=1[—=]in the instructions.

v Words in UNDERLINED CAPS refer to menu options that appear on the receiver's screen.

Use the [CLICK STICK] [1][{] movement to scroll up/down a list and highlight an option.

Press in on the [CLICK STICK] to select a highlighted menu option. In these instructions,

“select’ would mean to highlight an option and press in on the [CLICK STICK] to select that

option.

Words in CAPS refer to data fields or screen titles.

If you press and hold the [CLICK STICK] for at least two seconds this allows you to mark your

current location as a waypoint.

AN
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v' To exit out of any menu, use the [CLICK STICK] [«][—] to select the on-screen “X” button (in
the upper right corner) and then press in on the [CLICK STICK].

Initialization in the lab

1. Power up the GPS unit
1.1.To begin, press and hold the [POWER] for a few seconds to turn the unit On/Off.
Read the warning message and then view the SATELLITE page. CHANGE THE
MODE SO THAT THE UNIT IS NOT USING THE SATELLITES.

2.0 Clear any previously stored Waypoints from receiver memory:

2.1 In the MAIN MENU, Press [FIND] to access any previously collected waypoints.

2.2 Select WAYPOINTS and then select NEAREST (you will see a list of any previously

stored waypoints that are nearest your current location).

2.3 Select the OPTIONS MENU (the page icon at the top right of the screen) and select
DELETE ALL. Atthe warning "Do you really want to delete all waypoints?” — select
YES. This will delete any previously stored waypoints that are near to your current
location. There may still be some GARMIN factory stored waypoints that are not
deleted.

2.4 Press [PAGE] to return to the MAIN MENU.

3.0 Set the correct Time Zone for our location:
3.1 From the MAIN MENU, select SETUP and then within this submenu, select the TIME
option.
3.2 The following parameters should be set in this menu:
3.2.1  Time format = 24 (hour time format)
3.2.2 Time Zone = US Pacific
3.2.3 UTC Offset =-08 hrs 00 min
3.2.4 Daylight Savings Time = Auto
3.3 Select the on-screen “X” to exit out of this sub menu and return to the SETUP
MENU. Note that you may need to press [PAGE] several times to get this menu.

4.0 Set the Position Format (coordinate system display) and Datum
4.1 From the SETUP MENU, select the UNITS option
4.2 The following parameters should be set in this menu:
421 Position Format = hdd°mm.mmm'
4.2.2 Map Datum = WGS84
4.2.3 Distance/Speed = Statute
4.2.4 Elevation = feet
4.2.5 Vertical Speed = ft/min
4.2.6 Depth = Statute
4.3 Select the on-screen “X” to exit out of this sub menu and return to the SETUP MENU.
4.4 Press [PAGE] several times to return to the SATELLITE page.

5.0 Change the default elevation to a more accurate reading

5.1 From the SATELLITE page, select the OPTIONS MENU from the top right part of the
screen.

5.2 Select NEW ELEVATION and manually enter the elevation in feet for Corvallis (246
feet), using the [CLICK STICK] to highlight the desired numerals and then pressing
the [CLICK STICK] in to select that number. Select “OK” to complete entry.

Press [PAGE] several times to return to the SATELLITE page
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Collecting waypoint positions for features in
the Field

1. IN THE FIELD

1.1. In the field, when you have your GPS units powered up wait for enough satellites (want
at least 4 satellites) to provide a 3D GPS Solution before continuing. You are now ready
to navigate. On the Satellite page, check the relative signal strengths of the numbered
satellites from step 1. Also note where, within the Skyview graphic on the receiver,
these satellites are located. The inner ring represents a view above you at a 45° angle
from vertical, whereas the outer ring represents the horizon and the center represents
directly overhead.

Hint: you will have to stand in one place with the GPS unit away from your body for a few
minutes to get a sufficient number of satellites with strong signal strengths. This should
be your standard method of data collection for each of your data points. Don’t rush the
collection of data as your accuracy readings will be very poor.

2. RECORDING WAYPOINTS
2.1. To record the receiver's current position as a waypoint:

2.1.1. From the SATELLITE page, position the GPS receiver near the feature location
you want to mark. Wait for a sufficient number of satellites to be tracked and a low
enough value for the accuracy reading (z 20 feet is desirable and lower is better).

2.1.2. To collect a waypoint, press and hold the [CLICK STICK] until the MARK
WAYPOINT page appears. The waypoint is automatically assigned a sequential 3-
digit number.

2.1.3. From this screen, record on the GPS Record Worksheet, the waypoint ID, as well
as the location in Latitude/Longitude and the elevation.

2.1.4. To save the waypoint, with the cursor highlighted on the “OK” field at the bottom
of this screen, press the [CLICK STICK] to store this waypoint to the GPS memory.

2.1.5. If you do not want to save the waypoint, press the [PAGE] button before pressing
any other to cancel the collection of data.

2.1.6. Once the waypoint is saved, the unit will return to the SATELLITE page. Without
moving away from the recorded location, record the position accuracy reading as
displayed in the top panel of the screen (status window). This will give you a
general idea of the accuracy of the GPS waypoint just recorded.

NOTE: This is a quick way to save waypoints. When this procedure is used, the receiver
automatically assigns labels to each saved waypoint. Provided that the receiver's waypoint
memory has been cleared, the first waypoint you save will be assigned the label “001”, the next
one will be saved as “002” and so on. You can save up to 500 waypoints in the Garmin eTrex in
this way.

You could name each waypoint with your own creative label, and identify it with a special symbol.
To speed up the process, we have used the default entries. However, you may personalize the
Waypoint by changing the Name field and map symbol field. To edit these attributes after you
have saved the waypoint, press the [Find] button to open the Find menu. Select WAYPOINTS,
then select NEAREST. A list of the current waypoints will be displayed. Select a known
waypoint, using the [CLICK STICK]. Within the flag symbol, select the numeric identifier for that
waypoint. An alpha-numeric keypad will appear on the screen. Select each letter or number to
form a unique label, then, select “OK” to enter this data. If you like, you may also change the
waypoint symbol by selecting the symbol block. A map symbol list will appear. Select the
desired symbol with the [CLICK STICK]. To save the waypoint, with the cursor highlighted on the



Page 5 of 11

“OK” field at the bottom of this screen, press the [CLICK STICK] to store this waypoint to the GPS
memory.

2.2. When your team has completed their GPS data collection of data points defining the

new Engineering building, the future COAS building and the Environmental Lab (as well
as the waypoints for the Beanery, Subway and the outline of Fung's, please return to the
Digital Earth lab.

New GIS skills:

Downloading the GPS data to the computers

Projecting data using the ArcView Projection Utility

Uncompressing data

Accessing metadata (“data about data”) from a web site

Adding and viewing images

Adding GPS data

Renaming views

Creating new shape files and adding attribute information.

On screen or “heads up” digitizing

Producing a map of your study area that includes the 6 map elements

Downloading data from the Garmin:

1. Transferring data using the DNR Garmin utility

1 Note that each student will need to do the following steps individually at your own
computer, even though you collected the data in pairs (or you can just e-mail the
points to your partner or get them out of the guest file).

2 To safely connect the GPS unit to the computer, you will need to shut down your
computer. From the Start menu, select Shut down (make sure the option is to
completely shut down, not to restart). Click OK. Wait for your computer to shut
down.

3 The GPS unit should be turned off at this point, if it is still on. Using the cable
provided, open the rubber flap at the top back side of the eTrex GPS unit and slide
the GPS connector into the unit. Make sure you align the slot in the connector with
the raised guide on the GPS unit.

4  Then carefully connect the cable to the computer through the db9 port (serial port) in
the back of the computer (the port has nine (9) pins and is located at the top left
corner at the back of the computer with the aqua plate). Your eTrex is now
connected to the computer. Power up the computer and log in.

5 We are now ready to setup the interface format. Power up the GPS unit and wait for
it to finish initializing.

6  The Minnesota Department of Natural Resources (DNR) has written a utility that
easily downloads GPS data from a Garmin unit directly into ArcView format. This
utility can be found on the desktop of each computer in Digital Earth.

7 To start the utility, double-click on the DNR Garmin icon on the desktop.

8 This is the first time the utility has been used on your computer and so, in a pop-up
“Set Default Projection” window, you will be prompted with the question: “Would you
like to use the Default Projection (NAD83 — UTM Zone 15)?” Guess where UTM
Zone 15is? You will answer “NO” to this question so that we can set a different
default projection.

9 In the status bar at the bottom left of the window, you will see “Connecting...” and
then “Connected” when the utility has successfully identified the Garmin GPS unit.
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A DNR Garmin Properties window will open with the Projection tab selected. From
this menu change the following parameters:

1.10.1. POSC codes: EPSG 4326

1.10.2. Datum: WGS84

1.10.3. Projections: No Projection
IF the DNR software doesn’t find the Garmin unit, just power down the GPS unit and
then start it up again. The DNR Garmin utility should automatically find the Garmin
unit and set up the correct interface. If this is not the case, set the following
parameters, under the GPS menu, Set Port should be Port 1, and Set Port should
be Baud Rate of 9600.
From the main menu bar, select the Waypoint menu - Download. This command
automatically downloads the waypoints to the DNR Garmin interface. Note that data
are listed with the Waypoint ID and latitude/longitude. The waypoints were collected
in latitude and longitude (geographic coordinates) using WGS84 as the datum and
this is the coordinate system that we are using to create an ArcView shapefile.
Within this DNR Garmin interface, you can delete any records that are not needed
by clicking in the far left column for that record and then clicking the Delete button
(big red X) on the left panel of the interface. If you collected two points for one
location and know that one of them is bad, then delete it now. If you're not certain
which is a better data point wait until we view the data in ArcView before deleting
extra waypoints. In addition, if the Garmin unit had any factory waypoints already
stored in it, delete these records at this time.
To save your waypoints, Go to File->Save to->file..., then save the file to your
workspace and title it “lab_5_data”. Use one of the text formats for your file type.

Projecting the GPS geographic coordinates

2. Use the ArcGIS Projection Utility to transform Geographic coordinates

1

Now we need to get the x,y,z coordinates into ArcGIS. Go to TOOLS — ADD
XY data. In the choose table from the map or browse to another table filed browse
to your folder where you saved the Garmin data points. After selecting the correct
table, select a coordinate system by clicking EDIT in the bottom right of the Add
XY Data tool. Then click SELECT then click Geographic Coordinate Systems
(this allows you to choose a predefined coordinate system from a list) then click
WORLD and the last one on the list “WGS 1984.prj” which is the projection that
you gathered the data in. Click ok twice — Now you have projected your data.
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Create a shapefile from your displayed points.

Right click on your point layer you just displayed (lab_5_data.events) Go down to Data-
> Export Data. Change the filename to newbuildings.shp and export it. Select yes for
adding it to map now. After you shapefile “newbuildings” is created, remove the
previous layer, keeping only the new “newbuildings” shapefile loaded.

Making a New Shape File

Next we need to make the polygons out of the engineering building, the future COAS
building, the Burt extension and Fung's maple garden - you can’t make world class
Chinese food in a point you really need a polygon.

1 Open Arc Catalog (yellow icon —looks like a file drawer or go to the start menu).

2 Browse to your personal folder and right click and click in the far right window
(see screen shot below). Click new and then shapefile.
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3 Name it fungs and change the feature type to Polygon. Click on the Edit...
button and Select to set the GCS to WGS 1984.pr;j.

4 Repeat steps 2 and 3, creating a polygon shapefile named new_buildings.

5 Go back into ArcMap. Add the new shapefiles to your data frame. Open the
Editor toolbar (available under Tools) and select start editing from the toolbar
menu. Make sure that the fungs file is in the folder you start editing. Change your
target if you have to.

6 Click the pencil (Sketch tool) and connect the dots around fungs — double
clicking on the last dot.

7 Go back to the editor tool bar and save edits - now you have a polygon to cook or
eat inside of.

8 Change your target to new_buildings. Repeat step 6 for the engineering
building, the future COAS building and the Burt extension. Save your edits and stop
editing.

Now we need to see how the new data matches up with existing datasets like streets. Is Monroe
in the right place? Are the data points in the middle of the street or on the right side? Let’s look
at the streets and see.
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Adding other Datasets

In the real world, data comes in many different forms. Often the data has to be
processed to suit your needs. In the GIS world, one of the biggest processing steps is getting
your data in the right projection so it all lines up appropriately for accurate assessment. In
the United States, a wealth of data exists for free and is easily obtainable (thanks to Uncle
Sam). The problem is that datasets you download can be in different projections, depending
on who created the file. ArcGIS gives you the capability to take that dataset and transform it
to the appropriate projection for your project. (Metadata can be crucial to finding what the
original projection of the dataset is in)

* Add the Streets shapefile to your map project.
* Add the Streets_Project shapefile to your map project. This file has already been
transformed for you.

The Street layers do not match up! They are identical datasets from the same source.
Streets_Project has been transformed from the NAD27 datum to NAD27 (WGS84).

Question: How far off are the two coordinate systems in meters? (hint: you can change the
display units by going to the properties of the data frame)

e After you have answered the question, remove the untransformed Street layer.

* Add the buildings shapefile from the data folder. (Click OK if there is a warning)

Notice how the store points line up with the Streets, but the buildings are misaligned. You can
right click on your buildings later and select Properties-> then select the Source tab. There you
will find what projection the dataset is currently in.

e Open up ArcToolbox and expand Data Management Tools -> Projections and
Transformations -> Feature. Select Project.

* In the Project Window, select your buildings shapefile for the Input Dataset. Verify or
change the Output dataset path so that it outputs to your student data folder. (name it
Buildings_Project)

* For Output Coordinate System, click the select (hand) icon to the right. In the Spatial
Reference Properties window click on the Import... button. Navigate to your
new_buildings shapefile, select it and click Add. Then hit OK.

e For Geographic Transformation, click the down arrow and select
NAD_1927_To_1984_10. Finally, select OK. It will crunch out the transformation and add
it to the top of your Layer list. You can go ahead and remove the old buildings layer

Q Given the accuracy measurements of your data points (you wrote this down in the field) do the
points for the Beanery, Fungs, and Subway line up with the street layer?

- The buildings and streets data was obtained from City of Corvallis, Public Works Department,
1245 N.E. Third Street, Corvallis, OR 97339. Color images are 6” pixel digital aerial
orthophotographs (DOQs) taken April 29, 2002 and processed by 3Di West/GeoTerrra Mapping
Group. 3400 West 11th Avenue, Eugene, OR 97402

Adding Attribute Data to the newbuildings and Fungs Shapefiles
The power of GIS is combining spatial information with non-spatial data. We are going to add
information to your new_buildings and individual building polygons that you created.
* Open the attribute table for newbuildings (the point file). If you wish you can delete fields
by right clicking on the field name and “delete field” for any excess fields you do not need.
* Add afield by selecting options->Add Field
* For Name, Type Hours. For Type, select text. Create another field for the store name.
* Display the Editor Toolbar if it is not already displayed. (Do this by dropping down from
the Tools menu and selecting Editor Toolbar.
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Under the Editor Toolbar, dropdown from Editor and select Start Editing. Select the path
that displays your created shapefiles in the window

Make sure your Target is set to newbuildings. On the Editor Toolbar, use the edit tool
(the arrow) and click on the point that represents the Beanery (Subway). When you have
selected the point, click on the attribute button on the Editor Toolbar (you can find out
what each button is by holding the cursor over it).

In the attribute window you opened up for the Beanery(Subway), enter the Name and
Hours into the appropriate field by clicking on the value space next to the field name.
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* Using what you have just learned, edit the fungs shapefile similarly. When editing
the newbuildings shapefile, you should delete the corner points of the individual
buildings since you already created a polygon layer of them (select the point, right
click, and delete).

e Save your edits and stop editing.

Hyperlinking Features

ArcMap gives you the ability to link features in your datasets to outside information. This can be
to an outside file or a web address. We are going to link our store points to photographs of the
store stored in your data folder. You can look at the photographs by browsing with My
Computer.

Once you have decided which pictures to use. In ArcMap, use the identify tool on your
newbuildings layer and click on the Beanery. Right click on the identified feature in the
Results window and select “Add Hyperlink.” Keep Link to a Document selected and
browse to your selected picture you want associated with your point. Now click OK. You
will notice that your hyperlink button becomes active. You can now use it to select your
point and see the picture.

Add a picture for Fung’s.

Q Explore the City of Corvallis FTP site,
ftp://ftp.ci.corvallis.or.us/pw/gis/readme/datadictionary.html for information (metadata) on the

data layers we will be working with. Answer the following questions in your lab report:

1
2
3

What is the purpose of the data dictionary?

In what coordinate system are all of the data stored?

What is the Vertical datum used for this coordinate system? (hint: you'll have to read
through the data dictionary for this information).
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4 List five (5) other data sets that are available through the City of Corvallis GIS (include
their names and descriptive information).

Make a Map Layout of your newbuildings and a screen shot of a hyperlinked image.
You screenshot can Iook like this: (you can edit and crop in Photoshop first if you like
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When making your map layout. Remember a North Arrow, Legend, Scale bar, Title, Name, Data
Source, and Neatline. You can label your stores by going to properties of your newbuildings layer
and using the label tab (select Name for Label Field). For labeling any streets or buildings from
the buildings_project shapefile, you will have to insert the label yourself. (If you open their
attribute tables you can see that there is no field with street names or building names) You can go
ahead and label Wilkinson Hall and Monroe Street. Play around with your layout tools and use
the help if necessary. The question mark button is a quick way to find information about what a
particular button does. When you are done crafting a nice map layout, export it as a jpg into your
answer document.

Assessing the accuracy of the GPS data points

* Creating Buffer polygons around the GPS data points

* To get a sense of the level of positional accuracy obtained by the GPS units you will
create a buffer around each data point that represents this positional uncertainty.

e Manually calculate the average accuracy value(you wrote these in you GPS log) for all
the data points you obtained. You will use this value as a general representation of the
distance with which to create a buffer, even though some of the data points were very
likely more accurate.

* Open the toolbox (the little red box icon in the upper right) click index and type in buffer.
Click your store point file (the location of the newbuildings) as the input field and then
change the units to feet. Then type in the average accuracy in to the Linear unit field.
Make sure you are saving it to your file (that is the output field).

* Create a map layout of these buffer polygons to document the level of positional
accuracy obtained with the eTrex GPS units. Your map should include the six (6) map
elements presented, including an appropriate descriptive title. Include this map in your
Lab report



